
Installing XP SP3-Access Denied 
By Bob Elgines, CRCC President & Editor,  
elginesz@rraz.net 
 
I tried installing Windows XP SP3 upgrade several times. 
Talking with Microsoft rep’s, I shut off my antivirus, up-
dated my BIOS, but nothing seemed to work. Then I de-
cided to do a search and found “Access Denied” informa-
tion and over 340, 000 other people had used this same 
area. For some reason a changeable entry in the Register is 
locked and will not allow SP3 to change it. 
 
First, do a right click on "My Computer" icon and select 
"Properties" to see if it has been installed. 
 
Here is what you need to do, if the Error message read 
“Access Denied” or “Service Pack Installation Did Not 
Complete”. First read your Svcpack.log, located under the 
Windows folder in case you forgot what the error message 
said, it should be at the bottom of the log. 
 
Next Backup your Register, then download and install 
“Subinacl.exe” from www.microsoft/downloads/
details.aspx?FamilyID=e8ba3e56-4a91-93cf-
ed698Se3927b&displaylang=en 
 
Start Notepad, then enter the following text: 
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Save As “Reset.cmd”. Now double click on this file. It will 
take a while to complete its job. 
 
Reboot your computer, you are now ready to install Win 
‘XP SP3. Go to windows update if you need to find SP3 
update. It should install with no problems or errors.       ��
 
 

Reading “DOCX” and “DOCM” Files 
By Bob Elgines 
 
Microsoft does it again, MS Office 2007 produces a files 
with the extension “.docx & ,docm”. If you are using MS 
Office 2000 or 2003 you will not be able to read them, but 
you may down load Microsoft’s “FileFormatCoverters.exe” 
from : 
 
http://www.microsoft.com/downloads/details.aspx?
FamilyId=941b3470-3ae9-4aee-8f43-
c6bb74cd1466&displaylang=en 
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This will enable you to read the 2007 new formats. It is 
approximately 28 MB in size and installs with no problems. 
 
Users of MS Office 2007 should notify your people that are 
send these files, that this update is available, or they will not 
be able to read them. Some people and businesses can not 
afford to upgrade their software and deal with training that 
might be needed. So this will at least allow them to read 
such files with previous software.        �  
 
 

Regular Meeting Minutes 
October 27, 2008   

 
Larry LaRue officiated at the regular 
New Users group before the regular 
meeting.  It was well received and 
enjoyed by all attending.   
 
CRCC meeting, Oct. 27, 2008  called 
to order by President Bob Elgines at 7 
pm.   

 
Asking for new visitor introduction, Jim Garside introduced 
himself as a visitor. 
 
Minutes were approved as recorded in the monthly newslet-
ter. Treasury report also approved as recorded in the news-
letter. 
 
No more old business. 
 
New Business: 
Christmas Party was discussed and after some discussion, it 
was decided to look into having the party at Pizza Hut.  
They have private rooms available and several members 
have attended successful parties there.   
 
Bob Elgines is going to look into booking a room, dates and 
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cost of our having our party there.  We will have informa-
tion and date available, cost and other details at our Novem-
ber meeting. 
 
Questions by members were discussed.  Members shared in 
helping re: problems members were encountering with their 
computers, programs and downloading updates, etc.   Ques-
tions are always welcomed! 
 
A certificate was presented to Carolyn Pimental for her 
faithful service as welcome person, Sign In and overseeing 
our 50/50 drawings each month.  Carolyn has provided 
these services for our club for several years.   
 
50/50 drawing was won by Victor Gagnon.  Nelda Van 
Enger and Ruth Brown won door prizes.   
 
Larry LaRue presented our program on Windows Explorer.  
Folders, options, manipulation, organizing, customizing our 
files were explored in depth.  Also discussed and demon-
strated is the close interrelationship between Windows Ex-
plorer and Internet explorer.   
 
Meeting was adjourned at 8:30 pm.   
 
Notes for these minutes submitted by Betty K. McReynolds 
in the absence of club secretary.       �  
 



 

  CRCC TREASURER’S  
  REPORT 

10/1/08 Through 10/31/08 
 By Dennis Sigurnjak 

 
 

Beginning Balance:   
Income:  
 Membership  
 50-50 collection 
 Interest  
  
Total Income: 
 
Sub Balance: 
 
Expenditures: 
 Supplies 
 Postage 
 
Total Paid Out: 
 
Ending Balance: 

Moving on to Vista – Part 8 
by Neil Stahfest, Librarian, Tacoma Area PC User Group, 
Washington  www.tapcug.org  ncstahfest@msn.com 
“Obtained from APCUG with the author's permission for 
publication by APCUG member groups.” 

 
Windows Vista is becoming more popular 
every day, but there are still several special 
features that few people are aware of! Be-
sides the energy saving features I mentioned 
last month, there's another feature that goes 
largely unnoticed by the average user. It's 

about displaying time in multiple time zones using Vista's 
system clock. It works very well, particularly since we work 
with countries all around the world and are no longer con-
fined to one time zone. It also helps when you intend to chat 
with a friend or family member who lives in another part of 
the country. Now, instead of calculating different time zones 
in your head, you can have a handy toolbar on your Vista 
computer that will tell the time for you.  
 
1. The first step is to right click on the clock in your system 
tray at the bottom of  
your desktop.  
2. Select Adjust Date/Time.  
3. Click on the Additional Clocks tab at the top of the win-
dow.  
4. Choose the checkbox that you want to show the addi-
tional clock.  

5. Next, pick a time zone and give it a title.  
6. You can add up to two additional time zones this way.  
7. Apply your changes.  
 
To see the additional times, just hover your mouse over the 
clock in the system tray.  
Vista's Service Pack 1 is out, if you have automatic updates 
enabled on your PC its should already be installed. So what 
does SP1 do? Microsoft previously announced that Service 
Pack 1 would improve the operating system's performance 
and security. It would speed up file copying, waking up from 
sleep and hibernation faster and add and extract files from 
compressed folders faster.  
 
When you install SP1 it apparently checks to see if you have 
installed previous updates and if it doesn't find them it in-
stalls them. Then in proceeds to install it's � new �  fea-
tures. I had used automatic updates to keep my installation 
current and Service Pack 1 installed quickly on my laptop 
without any apparent problems.  
 
Did I see any improvements? <sigh> Not really. I saw no 
noticeable improvements in performance. As far as I could 
tell start-up time was the same and file copying was the same 
but the file copy � fix �  I had previously installed (see Mov-
ing Up to Vista – Part 7). Other people have reported similar 
impressions. One person reported Vista with SP1 com-
pressed files faster than without SP1 but it is still slower than 
Windows XP.  
What about new features? Frankly, the only one I looked for 
and found was the disk defragmenter. Pre SP1 when you 
selected the defrag function you had no choices. The func-
tion simply defragmented your all of your hard drive. With 
SP1 installed, the defragmenter first examines your computer 
and makes a suggestion as to whether your drives and parti-
tions need to be defragemented. There's also an option to 
schedule defragmenting at regular time intervals. I don't re-
member if this was available pre-SP1.  
If you select the � button�  to defrag your hard drive, you 
see a new screen which gives you the alternatives to defrag 
all of your partitions and drives or select specific partitions 
and hard drives to be defragmented. As with pre-SP1 Vista, 
you can defrag your hard drive(s) while continuing to use 
your computer. There is no specific information that tells 
you how badly fragmented your drives are or how much 
space is used. In my opinion, the disk defragmenter in Win-
dows XP was more useful. For that kind of detail you'll need 
to use a third party disk defragmenter. I would say that 
Vista's deframenter with SP1 is improved but still a disap-
pointment.  
 
And that's my general impression about Vista SP1. I'm dis-
appointed. The speed improvements that were predicted just 
don't seem to be there. Maybe the security is improved but 
it’s not obvious to me. Maybe Service Pack 2 will be better... 
 
This article has been provided to APCUG by the author 
solely for publication by APCUG member groups. All other 
uses require the permission of the author (see e-mail address 
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few days. Once again not finding any online solutions I 
contacted a phone support tech who was able to direct me 
to a download utility that cleared the problem and allowed 
me once again install version 9. 
 
While the above debacle was frustrating don’t let it deter 
you from considering the purchase of this capable applica-
tions suite. So let’s look at why you should consider own-
ing this product.  
 
Once you get past the install you will see a super clean in-
terface with applications divided into seven primary areas; 
Audio, Data and Backup, Copy, Media and Devices, Photo, 
Video, and Tools. Each application provides another set of 
choices. Audio has (13), Data and Backup (5), Copy (5) 
Media and Devices (2), Photo (9), Video (11), and Tools 
(8). Now that is a huge chest of applications at your dis-
posal. If you were to purchase each primary application 
separately it would cost you a few hundred dollars. This 
package sells for about $100 but if you watch for sales you 
can buy it for much less.  
 
When you think of Roxio and burning software the primary 
reason most people purchase the product is for those tools. 
The Copy and Data and Backup modules take care of those 
basic requirements along with some other goodies. For any-
one familiar with an older version, you will still find the 
original Creator Classic still there but spruced up. That old 
standby is quite the workhorse. You select the type and size 
of disc you want to burn and it will keep you updated on 
available space as you move files or folders you want to 
burn into a holding area. Once your files and folders are 
selected you can burn your CD/DVD directly or make an 
image for later burning. Of course you have advanced op-
tions to define the type of disc, speed, copies, etc. You can 
also make a bootable or multimedia disc and go directly to 
creating disc labels of your burn project. 
 
The backup module provides capability to be selective of 
the files you want backed up or restored and at what fre-
quency. If you want more powerful options then you will be 
provided an upgrade link. A range of backup devices and 
media including Blu-ray discs and HD DVD discs are sup-
ported. Large files can be automatically spanned across 
multiple discs as required. 
 
The Audio module provides thirteen selections that cover 
just about everything you could possibly want to do with 
audio. All the expected tools are there to rip CD’s into MP3 
files or create audio CDs from other formats. You can make 
custom CD’s with fades, effects and mixing. Tools are there 
to edit song information and to do batch conversions to 
formats of your choice. One module allows you to instantly 
capture any audio playing on your computer, including 
streaming radio. There is one utility “Convert LPs and 
Tapes” that I was especially enthused about. At our meeting 
we have had the question of how to convert LPs and Tapes 
asked many times in the past. While there are several meth-
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above).       ��
 
 

Roxio Easy Media Creator Suite v10  
By John Roy, President, The PC Users Group of Connecti-
cut 
www.tpcug-ct.org     johnroy1@comcast.net 
“Obtained from APCUG with the author's permission for 
publication by APCUG member groups.” 
 
Roxio, a division and brand of Sonic Solutions, has been a 
leader in burning software for many years. I personally 
have used the product since it was distributed by Adaptec 
several years ago. The CD/DVD burning software today far 
exceeds the basic functions that existed in those early days. 
Roxio Easy Media Creator (EMC) will accomplish so 
much more than the basic burning tasks and is now a full 
featured suite. 
 
Doing this review has allowed me to explore and appreci-
ate the many applications within this suite. Because EMC 
is so comprehensive I will provide an overview in this arti-
cle but follow up with more details in future issues of our 
newsletter.  
 
Before I start boasting about some of these neat applica-
tions I must discuss some installation issues. The product 
would not install on my primary computer! After trying 
several times to install under various scenarios I checked 
for possible solutions using Roxio’s web product support 
and also their user forum. None of those sources provided 
any clues so I connected with technical phone support. I 
was quite surprised that the wait time was very small and 
the technician was professional and extremely competent. 
Unfortunately after almost two hours of phone support the 
problem was not solved. 
 
The tech support effort involved major system modifica-
tions including deletion of all files associated with my 
original EMC version 9, my Nero burner software, a com-
plete registry purge line by line of anything remotely asso-
ciated with or influenced by Roxio software, removal of all 
anti-virus software and firewalls, elimination of all startup 
files except system essentials and running registry clean 
utilities. Nothing worked! A trouble report was left open 
but I never received any further calls. In their users forum I 
did find one other person with the exact same problem and 
no solution.  
 
Fortunately I have a couple of other computers at my house 
so I tried installing the version 10 on both an older desktop 
and on my primary laptop system. The install went 
smoothly on both of those systems. So until I get a chance 
to rebuild my primary desktop I won’t know if I can ever 
use the latest version on it. On a side note before trying to 
install EMC version 10 I had version 9 successfully work-
ing. After all the system changes I could no longer load my 
EMC version 9. So now I struggled with that problem for a 



ods to accomplish this, Roxio EMC has made it easy and 
crystal clear with this application. So for those of you that 
have a desire to do this you should give Roxio EMC serious 
consideration. 
 
The Photo application contains a full featured photo suite 
with powerful editing, effects and touchup tools. It is com-
plete with all the ancillary things you want to do with pho-
tos such as creating slideshows, panoramas, albums, greet-
ing cards, calendars and layout templates. You can quickly 
optimize a group of photos for sending email.  
 
The Video application is another full featured suite for im-
porting, editing, customizing and exporting video into vari-
ous formats. Included is CinePlayer a full featured video 
player. The features are similar to those found in Pinnacle 
Studio or Adobe Premier. While some of Roxio EMC tools 
are not as robust as the leaders you will find some tools not 
available in the others. The fact that it may not be as flexi-
ble as the stand alone programs it will be easier for the nov-
ice. If you are a true video buff then even if you own other 
video software you would also want to have EMC in your 
software chest. 
 
The smallest stand alone module is Media Manager that 
enables users to easily browse, manage, share and protect 
their media files. The final application module is Tools. 
This module is used for creating disc labels, obtaining drive 
information, erasing discs, creating virtual disc drives and a 
few other assorted utilities.  Roxio EMC is Vista compatible 
and includes gadgets for doing things directly from the 
desktop. 
 
I’m certain most computer users will find enough applica-
tions on Roxio Easy Media Creator to make the investment 
worthwhile. If this review has captured your interest pay a 
visit to Roxio’s website at http://www.roxio.com/. They 
have some great videos that will demonstrate these neat 
features.        �  
 
 

Forwarding e-mail 
By Frank Kelly 
 
Unfortunately, Microsoft decided long ago for reasons that 
escape me that whenever we forward a message it was nec-
essary to insert a > symbol at the beginning of each line.  
That makes for a messy e-mail and I try to remove that clut-
ter.   
 
One way to remove them is to copy the whole message you 
are about to forward and paste it into Word, where it is easy 
to search for > and replace it with nothing, then paste the 
result back into a new e-mail.  Outlook Express won’t do 
that directly, but there is a simpler way.  While viewing the 
original message, press ctrl-A, Ctrl-C to select All and 
Copy All (or click Edit, Select All and Edit, Copy All if you 
prefer), then paste it all (Ctrl-V) into the body of a new 

empty e-mail message instead of forwarding the original 
directly.  Of course you will also want to delete the ----- 
Original Message ----- header and other junk while you’re 
at it.  Your e-mail buddies will appreciate your efforts.     �  
 
 

E-Mailing Photographs 
By Richard Kennon, Editor, Amador Computer Users 
Group, CA  www.acug.net  Drtrdguy@volcano.net 
“Obtained from APCUG with the author's permission for 
publication by APCUG member groups.” 
 
First, we must understand that photograph (image) size in 
the camera and in the computer is measured in pixels. 
These are the basic dots of color that make the picture. Do 
not pay any attention to anything that says “inches” or 
“pixels per inch.” These terms are meaningless when we are 
considering a picture either in the camera or in the com-
puter. They may come into play later if we want to print the 
photo on paper. But, that is another subject for another 
time. For now, we think only of pixels. Most cameras re-
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the Pixel Di-
mensions in 
play and that is 
what we want. I 
selected the 
Width box and 
changed the 
width to 800 
pixels. Since the 
Constrain Pro-
portions box is 
selected, that is 
all I have to do.  
 
Note, down at 

the bottom, that we have several choices of sampling algo-
rithms. This is frosting on the cake. I read somewhere that I 
should use Bicubic Sharper when downsizing so that is 
what I do. Most programs don’t give us all these choices. 
Then we should click on File>Save As and give the photo a 
new name. I often just use the same name and add “_800px” 
so the next time I will know it is ready to e-mail. Here we 
can choose the JPEG format and the compression amount. 
Photoshop Elements 6 is out now and sells for about $100. If 
you are able to spend that much and want one of the best 
editing programs, I highly recommend it. 
 
Let’s look at Picasa2. It is a free program from Google and 
looks really good but I do not have much experience with it. 
By all means, try it first because the price is right! When it 
comes to e-mailing photographs, it is a little more automated 
but not any easier to use than Elements. First, click on 
Tools>Options>E-Mail. Then select the width you want in 
pixels. There are six choices. Then click on Apply  and OK.  
 
The next step is to click on File>E-Mail  and you will get 
three choices of how you want to e-mail your photos. Fortu-

nately, I use Out-
look Express so 
my choice is 
listed. 
 
When I clicked 
on Outlook Ex-
press, an e-mail 
page popped up 
with the photo 
attached. At this 
point we can 
write something 
else on the e-mail 
and send it. I rec-
ommend this so 
the recipient will 
know it is really 

from you and not something sent out by a virus. When I re-
ceive e-mails that only say “Attached”, I Delete them with-
out looking at the attachment. This saved me one time when I 
received a virus from my sister-in-law that she did not know 

cord too many pixels to e-mail. For instance a 6 megapixel 
camera will make a picture about 3000 pixels wide by 2000 
pixels tall and the file size may be several megabytes. Our 
screens are usually only about 1000 pixels wide (some are 
larger and some smaller). So, if we e-mail the native pic-
ture, it will be wider than the screen for the recipient and 
the file will be so large, it may take “forever” to download 
to the recipient’s computer. It is possible the service pro-
vider will not even accept it. 
 
There are two things we must do to make a photo e-
mailable. The first is to resize or resample the picture. We 
want to change the picture width from 3000 pixels to 800 
pixels, for instance. This process is called resizing or resam-
pling. We have to pick the best 800 pixels out of the 3000 to 
represent our photo. Well, no, that is not exactly correct but 
it simplifies things to think of it that way. We don’t have to 
worry about it because a lot of very smart programmers 
have developed ways (algorithms) to help us. Just remem-
ber, you want to resize or resample to get the photo down to 
a size convenient for e-mailing. I usually use 800 pixels or 
900 pixels width for pictures I attach to e-mails. 
 
The second thing to do to make a photo e-mailable is to 
save it in JPEG format (.jpg). That is a format that reduces 
file size a lot and picture quality a little so the picture can be 
downloaded more quickly and still be nice to look at. Some 
software programs give you choices of compression amount 
with numbers ranging from 1 to 10. One will result in a 
very small file but the picture quality will not be good at all. 
A 10 will give the very best quality but with a very large 
file size. A reasonable compromise is to use 5 or 6. I usually 
use 6. 
 
How do you do this? First, I will describe how to do it with 
a free Microsoft program. Then I will try to look at some 
other programs. 
 
Microsoft Power Toys for XP has a Resize Pictures toy that 
is slick and easy but feedback says it only works on XP. It 
can be downloaded at http://www.microsoft.com/
windowsxp/downloads/powertoys/xppowertoys.mspx. 
Right click on an image name or thumbnail in Explorer or 
My Computer and choose Resize Pictures. You are limited 
to four specific sizes but they are good choices. They don’t 
tell us what compression they are using but the results look 
OK. Unless you tell them under Advanced to replace the 
image in the file, it will make a copy. That’s good. They 
will add the word, “Large”, “Medium” or “Small” to the 
end of the name you have chosen. 
 
If you are happy with this solution, then read no further. 
But, if you want to use a picture editing program, maybe 
this will help. 
 
In Photoshop Elements 5, click on Image>Resize>Image 
Size and this window will pop up. Note that there is some 
garbage at the bottom about “inches” but we will ignore 
that. First we will click the Resample Image box. That puts 
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she sent. She spent weeks and dollars getting her computer 
back up. Oh, I digress. If you want to send more than one 
picture (and, who doesn’t?), you must select the picture and 
click on the Hold button near the bottom of the screen. Do 
this for each photo you want to send and they will all be 
attached to the e-mail. The program automatically chooses 
JPEG format and a compression ratio but does not tell you. 
That is OK as the pictures I tried looked good. Picasa2 has 
considerable capability for editing photos in many respects. 
Try it! 
 
There are many other editing programs that I haven’t men-
tioned and have no experience with. In all cases you want to 
change the picture’s size in pixels by resizing or resam-
pling. Pay no attention to anything that says “inches” as that 
will have no meaning for this process. Sometime later we 
will talk about printing pictures, and then we will use 
inches.     ��
 
 

I'M ASKED... 
By Bill Funk, a member of the Arizona Association for 
Computer Information, inc. (ASCIi) 
www.asciigroup.org  editor@asciigroup.org 
“Obtained from APCUG with the author's permission for 
publication by APCUG member groups.” 

 
I just bought a Digital SLR camera; with 
the prices as low as they are, I couldn't 
resist. Since I want to take photos of my 
grandchildren, and the built-in flash isn't 
as powerful as I need, I bought a new 
flash. It's the same brand as my camera, 
and is supposed to be all automatic. But, 

the photos aren't right. I thought the better flash would let 
me take photos inside, and freeze the movement of the 
grandkids, but the photos are as blurry as with the camera's 
flash. 
 
What's going on? 
You're right, the on-board flashes on most DSLRs aren't 
very bright. Buying the new flash is the right idea, but it 
doesn't work the way many people think it does. 
 
You're probably using the camera as a Point & Shoot: set-
ting the camera to make the exposure decisions, and press-
ing the shutter button. There's nothing wrong with that, but 
doing things that way won't get your flash to work the way 
you want it to. 
 
Instead, you should use the Manual mode for exposure 
(check your camera's manual for how to enter the Manual 
mode). While you're looking at the manual, check to find 
the highest shutter speed you can use with the flash, too. 
 
Then, in Manual mode, set the shutter speed at, or maybe 
slightly below, that speed ( I use 1/125 sec on my camera; 
it's fast enough to freeze most action), then set the aperture 

(f/number) for the desired result as far as depth of field is 
concerned, and set the ISO as desired. Set the flash to auto 
(check the manual), and fire away. This way, the camera 
will use the settings you chose, ignoring the amount of light 
in the scene. The flash will check to see what the camera is 
set to, and fire itself, checking the results as it fires to give 
the right amount of light to the scene. Neat, eh? 
 
The way you're doing it will make the flash act as a "fill" 
flash, meaning the camera's exposure system will use the 
existing light in the scene to set the exposure, and the flash 
will intelligently fire to fill in shadows, but not be the major 
source of light in the scene. This is also the usual way the 
camera's on-board flash works, even though many cameras 
will set the shutter speed to take advantage of the flash's 
extra light to help freeze motion. The problem here, though, 
is that the on-board flash just isn't bright enough to light up 
a dark scene (such as a room) very well. 
 
One of the really neat things about digital photography is 
that, regardless of the actual type of the camera, experimen-
tation is cheap. In this case, once you get the basics of flash 
use down, you can experiment with different shutter speeds 
and aperture settings for different results. Also, off-camera 
flashes like yours will usually let you turn the flash head up 
and down, and side to side, for bounce flash. With bounce 
flash, you're bouncing the flash off the ceiling or wall. This 
tends to spread the light from the flash out to reduce that 
sharp look that a straight-on flash gives, and it also reduces 
harsh shadows (as well as changing where the shadows 
are); more to experiment with! 
 
This brings up another question: if you have an older flash 
from your film days, can you use it with your new DSLR? 
The answer is a very firm: maybe. The problem is that most 
older, film-era flashes have a higher trigger voltage than 
what DSLRs can tolerate. In other words, using that old 
flash can cause some expensive damage to your DSLR. 
There are some devices that can be put between your older 
flash and your DSLR's flash shoe that will solve the prob-
lem. However, a new flash will also work much better with 
your new DSLR, and do things that old flash can't even 
dream of doing.     �  
 
 

Windows Vista Performance - 1 
by Lynn Page, Editor, Crystal River Computer Group, FL 
www.crug.org   newsletter@crug.com 
“Obtained from APCUG with the author's permission for 
publication by APCUG member groups.” 
 
While here in Wyoming for the summer I have only my 
laptop for all of my computing needs. This means that keep-
ing Windows Vista performing well is important. I have 
noticed a slowdown at times. So I thought this would be a 
good topic to discuss. Just how much my laptop is slowing 
down versus my perception is hard to determine. While in 
Florida I use my desktop for many of the functions that I am 

November, 2008 CRCC Page - 7 



To see which programs load automatically start by looking 
at the icons in the notification area on the taskbar. Click the 
Show hidden icons button (greater than symbol at the left 
of the notification area) to see all icons and mouse over 
each to see the program name. Then look deeper with Win-
dows Defender to be sure you know every program that 
loads automatically at startup. You view and disable them 
in Windows Defender. 
 
The Software Explorer screen in Windows Defender shows 
startup programs which load automatically when you 
launch Windows. Disable programs that shouldn’t open 
automatically at startup. Restart the computer, check that 
they don’t automatically load, and then open the programs 
and use them manually. If there is a problem go back and 
re-enable to start the program/programs automatically. 
 
Defragment the Hard Drive 
Fragmentation of files makes the hard disk work to recon-
struct them and can slow down the computer. Disk Defrag-

menter rearranges fragmented data so your hard 
disk works more efficiently. I have Disk De-
fragmenter set to run on a weekly schedule, but 
you can run it manually. 
 
Disk Defragmenter is found in System Tools 
under accessories on the all Programs listing. 
Be sure to defragment all disks. It is especially 
important to defragment data partitions. 
 

Clean Up the Hard Disk 
With the large new hard drives it would seem that freeing 
up hard disk space would not be very important. But it is. 
With the ease of digital photography and the increasing 
size of digital files hard disks can and do fill up. So it is 
important to reduce the number of unnecessary files on the 
hard disk. Freeing up disk space can help the computer run 
faster. 
 
Before worrying about using a cleanup utility take a look at 
your data files. Review old original digital images, letters 
and other files. Delete those that are no longer necessary. 
Develop a filing system to save and store important files 
off your hard drive. I use external hard drives, CDs, DVDs 
and Zip disks. After deleting unneeded files and storing 
others off the hard drive use Disk Cleanup to remove tem-
porary files, empty the Recycle Bin, and remove a variety 
files no longer needed. 
 
Another idea is to reduce the size of the Recycle Bin. Right 
click on the icon on the desktop and click properties. Re-
view the settings and set the Recycle Bin size for each 
drive to an appropriate amount. Remember it should only 
be an exception when you need to retrieve something that 
you sent to the Recycle Bin. Don’t consider this another 
storage location. 
Disk Clean Up is found in System Tools under Accessories 
in the All Programs list. In the Disk Cleanup Options dia-
log box, choose to clean up your files or all of the files on 

CRCC Page - 8 November, 2008 

using the laptop now. I did notice that when I got my new 
DSL connection and associated software there was a dis-
tinct change. 
 
So here are some standard ideas to get the best possible 
performance from your Windows Vista computer. Most 
can also be said for other versions of Windows but the ac-
tual procedures may vary. 
 
Delete Unused or Never Used Programs 
Many new computers come loaded with programs or trial 
programs you won’t use. The trial and limited editions of 
programs are provided with the hope that you will try them 
and decide to upgrade to full versions. So hunt through the 
computer and see what is installed. Try out the programs if 
you want but when you are done with your look and see 
uninstall those you will not use or upgrade. Having unused 
or unwanted software on your computer might slow it 
down by using memory, disk space, and processing power. 
This is especially true if the program loads and runs in the 
background. 
 
This is also true of software programs that you purchase or 
download. If you try a program out and don’t like it or have 
one you like better uninstall it. I am familiar with this par-
ticular problem because I purchase almost every digital 
editing application that I see. I really only regularly use 
three but have several more installed on my home desktop. 
 
So uninstall all the application programs you don’t don’t 
use. Both manufacturer-installed software and those you 
installed but don’t use anymore. It is important to keep 
have good security and/or utility applications. But remem-
ber that these virus scanners, spyware detectors, disk clean-
ers, and backup tools may load automatically at startup and 
run in the background. So select the applications you need, 
keep them up to date and uninstall any others. 
 
To uninstall a program click the Start button and then Con-
trol Panel. In Control Panel under Programs click Uninstall 
a program. In the list of installed programs select the one to 
remove and then click Uninstall/Change and then follow 
the instruction in the dialog boxes. Some applications come 
with their own uninstaller that is listed in the All Programs 
listing. I generally check there first and use the manufactur-
ers uninstaller if it is available before using Windows 
uninstall. 
 
Control Which Programs Load at Startup 
Software manufacturers design many programs to load 
automatically when Windows starts. These programs open 
in the background so they’re readily available. You want 
that for your critical security software like virus protection 
and firewall and it can speed opening of programs you use 
all of the time, but for programs you seldom or never use, it 
wastes memory and slows Windows loading. Decide which 
programs should load at startup and stop others from auto-
matically loading. 
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 Happy Birthday! 
 
12/16  Clevenger, Bob   E.   
12/18  Engel, Janice    
12/29  Marcucci, Adell     
 
 
Flower: Narcissus; Stone: Turquoise 
 
And all those we missed!        ��
 
 

Editor Notes: 
By Bob Elgines 
 

Remember, O’REILLY will give us dis-
counts on all their books, now 30%. Get 
30% off a single book or 35% off two or 
more books from O'Reilly. Contact me for 
latest catalog or check out their web site.. 
You can also get a book free by doing a 
review.  
 

SmartComputing magazine has offered us a free subscrip-
tion for every 5 new or renewal purchases using our User 
Group code. Call 1-(800) 334-7458 or at 
https://www.smartcomputing.com/secure/membership.asp  
 
There is no restriction against any APCUG member 
group  using an article as long as it is kept in context, with 
proper credit given to the author.  These articles are 
brought to you by CRCC and have been provided to AP-
CUG by the author solely for publication by APCUG 
member groups. All other uses require the permission of 
the author.  
 
Association of Personal Computer User Groups (APCUG), 
an International organization to which this user group be-
longs. Please send author a copy of your newsletter if pos-
sible!        ��
 
 
 

Classifieds  
----------------------------------------------------------------------- 
FOR SALE -  Motorola Cable Modem, SB5120. If inter-
ested contact Lyle at ldulac@npgcable.com or 928-453-
1824 
----------------------------------------------------------------------- 
FOR SALE -  1GB (two 512MB matched modules) of 
DDR2 RAM for Laptops  $30, If interested contact Bob at 
elginesz@rraz.net or 928-855-4155 
----------------------------------------------------------------------- 

the computer. Select the hard disk drive to clean up, and 
click OK. On the Disk Cleanup tab select the check boxes 
for the files to delete, click OK, and then click Delete files 
to confirm the operation. The More Options tab lets the 
administrator clean files from all users on the computer. 
 
Don't Run as Many Programs at the Same Time 
How you use the computer has a big impact on its perform-
ance. If you’re like me you keep several programs and 
browser windows open at once. I almost always have Inter-
net Explorer, Outlook, outlook Express and Word open. 
Then when I am working with photos add at least Adobe 
Elements and Corel Paint Shop Pro Photo. Its worse when I 
am working on the CRUG newsletter because then I add 
Adobe GoLive to this mix. With all of this going on my 
poor laptop is truly toiling. Keeping all of these applica-
tions going really uses the memory. 
 
So if your computer is slowing down, see if you really need 
to keep all of the programs and windows open at once. I 
find it hard to do but when I am working with large appli-
cations like GoLive, Elements, Paint Shop Pro Photo and 
Word I sometimes close my email and browsing applica-
tions. Then when finished with the newsletter and web site 
I can check for new email and browse all I want. 
 
Turn Off Visual Effects 
If Windows Vista is running slowly, consider disabling 
some of its visual effects. These neat appearance goodies 
take resources. They area a large and nice part of Vista but 
if performance is affected trade the appearance for per-
formance. This is especially important if your computer is 
just barely powerful enough for Windows Vista. 
 
Control which visual effects to turn off, one by one, or let 
Windows make a selection. There are 20 visual effects you 
can control, like the transparent glass look, the way menus 
open or close, and whether shadows are displayed. 
 
Open Performance Information and Tools by clicking the 
Start button and then Control Panel. Next click System and 
Maintenance and then Performance Information and Tools. 
Click Adjust visual effects in the left pane of the Perform-
ance Information and Tools window. Select the Visual Ef-
fects tab. I have selected the Let Windows choose what’s 
best for my computer selected but you can make your own 
choices by selecting Custom. Or select Adjust for best per-
formance, and then click OK.       �  
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